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Introduction

Termy is a terminal emulation 
application and more that utilizes the 
Macintosh Communications Toolbox 
(CTB). The CTB allows Termy to be 
written for a single communications 
standard, and then used for any and 
all extensions written by other 
developers. A fantastic approach to 
solving the communications problem.
Termy used to be named uATerminal. 
Its name was changed because, well, 
to be honest uATerminal is a dull 
name. Termy seems more endearing.
Termy was created by taking the 
terminal emulation software from the 
commercial product uAccess and 
making a stand alone application.We 
have done this because we derive our 
living from the Internet, and feel 
compelled to give back as much as we



possibly can.
The most difficult aspect of using 
Termy for most people is simply the 
installation of the CTB. It is different 
for System Six and System Seven. It is
also more complicated than most 
application installations. However, 
once you have passed this hurdle, the 
remainder of the application is 
surprisingly straight forward.
Termy is to be distributed free. It may 
not be distributed as part of any 
commercial package, without the 
expressed written consent of ICE 
Engineering, Inc. Termy may not be 
distributed without the proper 
copyright and distribution notices 
contained within the software itself 
and in this manual.

NOTICE - DISCLAIMER



Termy is Copyrighted 1988-1992 © By ICE Engineering,
Inc.,  and  Tim  Endres.

Termy  is  provided  AS-IS with  no  warranty as  to  its
functionality or stability. The user of this software assumes
all responsibility for its use and all resulting consequences
of that use. Neither ICE Engineering, Inc., or Tim Endres,
will  assume responsibility  in  any way for  consequences
resulting from the use of this software, which is distributed
free  of  charge  with  full  disclaimer.



Basics

Communications Toolbox

The Communications Toolbox (CTB) is founded on a very simple 
principal –

most data communications are based on the three basic 
functions of connection, transfer of data, and display of 
data.

The novelty of the CTB is that previously each application had to 
write code that dealt specifically with each type of connection 
that it made, and each application had this redundant code 
contained within it.
Thus, is an application wanted to send data through the Serial 
Port via modem to another Macintosh, and also wanted to send 
data over AppleTalk to another Macintosh, then the application 
would have to contain code to handle the serial port, as well as 
code to handle the AppleTalk network.
Intelligent software designers thought – why doesn't someone 
write the AppleTalk code once and then everyone can use it.
Thus, the CTB was designed. With the CTB, the application 
developer writes code to one interface, the CTB interface. Then, 
the user selects from CTB tools to determine what the CTB 
interface actually does. Thus, the application never really knows 
where its data comes from, or how it is sent, it simply receives 
and sends data via the CTB. The CTB tools handle the task of 
getting the data physically moved from place to place.
The CTB goes beyond standardizing the data connection, it also 
standardizes the terminal interface, or the display of your data, 
and it standardizes the transfer interface, or the sending of files 
between computers. The three parts of the CTB are called the 
Connection Manager, Terminal Manager, and Transfer Manager.
Each manager has tools. These tools are files that you place in 
your System Folder. The files have icons that look like little puzzle 
pieces. These files contains code and resources that provide the 



CTB with functionality.
For example, the Serial Tool is a communication tool that provides
data communication via the Macintosh built in serial port. The 
AppleTalk ADSP Tool provides data communications via the 
AppleTalk network. The VT102 Tool is a terminal tool that provides
vt102 terminal emulation in a window. The XMODEM Tool is a 
transfer tool that provides file transfers via the XMODEM protocol,
which is popular for modem based connections.
The beauty of the CTB is that anyone can develop a new tool and 
it will be usable by the CTB and therefore by Termy. For instance, 
if you suddenly 



needed to connect to an SNA network, then a communications 
tool could be developed that knew how to communicate with SNA.



Getting Started

Installing The CTB

Users of System Seven do not need to install the CTB, since the 
CTB is built into System Seven. Please skip to the Installing the 
CTB Tools section.
Users of System Six have a much more difficult prospect when it 
comes to installing the CTB. In order to install the CTB, you need a
CTB Installation Floppy. This contains the Installer program and an
install script. Without this floppy, you will not be able to get 
started.
Most CTB based commercial applications (uAccess for instance) 
come with a CTB installation floppy. ICE Engineering will ship you 
one, but it costs $15. However, most public data sites, such as the
Internet, CompuServe, and others, have the CTB installation 
floppy on-line for downloading.
Once you have acquired a CTB Installation floppy, you must boot 
the Macintosh from the floppy. Once the Finder is available, 
double click on the Installer Script file. This will launch the 
Installer application. Once the Installer application has been 
launched, select your hard disk for the installation location, and 
click the Easy Install button.
Once the installation is complete, you must reboot from your hard
disk in order to use the CTB.
Installing The CTB Tools

Since the CTB is really only a frame work, you must install CTB 
Tools to be able to actually perform any communications.

NOTE: If you get an error #8 starting 
Termy, you did not perform this 
step correctly!

Again, the installation of the CTB Tools is different between 
System Six and System Seven.



System Seven users must install the CTB Tools in the 
"Extensions" folder inside the "System Folder". Copy all of the CTB
Tools that you intend to use into your Extensions folder inside the 
System Folder.
System Six users must install the CTB Tools in the 
"Communications Folder" folder inside the "System Folder". Copy 
all of the CTB Tools that you intend to use into your Extensions 
folder inside the System Folder.
There must be at least one of each type of tool (connection, 
terminal, transfer), or Termy will complain at startup time. Termy 
will not work 



without a connection tool and a terminal tool, but can work 
without any transfer tools.
Installing Termy

Installing Termy is very simple. Copy Termy to your hard disk.
Termy requires a preference file. This file is placed in the 
"Preferences" folder in the "System Folder" for System Seven 
users. The preference file is placed in the "System Folder" for 
System Six users. The preference file is named "Termy 
Preferences".
Termy will automatically create a preference file if one is not 
found.



Using Termy

Terminals

There is a basic concept in Termy. Terminals. Terminals are 
windows that allow you to communicate with other computers. 
You must define each terminal that you use. Fortunately, most 
people use only one terminal.
Termy provides you with a default terminal. This is the first 
terminal you should configure, since it is always available.
You may create new terminals with the New Terminal command in
the Config menu. Terminals are identified by a name.
You open a terminal via the Terminals submenu in the Terminal 
menu. The first item on the terminals submenu is Default 
Terminal. If you define other terminals, their names will appear 
below the default terminal.
Selecting one of the names in the terminals submenu will open a 
window that uses the Terminal Tool configured for the selected 
terminal, and communicates with the Connection Tool configured 
for the selected terminal. File transfers will be performed with the 
Transfer Tool configured for the selected terminal.
Closing the terminal window will cause its communications 
connection to be closed. This is why you are asked first before 
closing a terminal window.
Configuring a Terminal

To configure a terminal, you must first define the terminal's name.
This is done with the New Terminal command in the Config menu. 
This command will prompt you for a name for the new terminal. 
Of course, the default terminal is always defined, so you do not 
need to use the new terminal command to create it.
Configuring a terminal is a two step process. Since the 
configuration of a terminal's terminal tool and transfer tool require
a connection and a window, you must first configure the 
connection tool for the terminal. This is why the Terminal and 



Transfer commands are dim in the Config menu.
Select a terminal name from the Connection submenu in the 
Config menu. For now, use the Default Terminal. This will display a
large dialog box that is the CTB Connection Tool Configuration 
Dialog. This dialog box will allow you to select any connection tool
and configure it for use.
Configuring The Terminal Connection



Once you have displayed the connection tool configuration dialog 
by selecting a terminal name from the Connection submenu in the
Config menu, you will need to select a connection tool.
You select a connection tool from the popup menu in the upper 
left area of the dialog box. This popup menu should have choices 
such as Serial Tool, AppleTalk ADSP Tool, and Apple Modem Tool. 
These names depend upon the tool files that you installed in your 
System Folder.
The Serial Tool is used to communicate directly with the serial port
and any device attached to it, such as a modem or other 
computer. The Apple Modem Tool also communicates using the 
serial port, but it also performs the functions of dialing the 
modem and hanging up. The AppleTalk ADSP Tool communicates 
with other Macintosh computers over the AppleTalk network.
Describing the details of each tool's configuration is beyond the 
scope of this manual, but documentation for these tools is 
available from several sources, including your bookstore.
Selecting a tool in the popup menu will display the tool's specific 
configuration information. This configuration is usually fairly 
straight forward.
Configuring The Terminal Terminal

Once you have configured the terminal's connection, you must 
open the terminal to configure its terminal and transfer tools.
You open a terminal using the Terminals submenu in the Terminal 
menu. Select the default terminal and it will open a window for 
the terminal and attempt to open its connection tool.
If the connection is successfully opened, the terminal window will 
be displayed and should contain a blinking cursor.
Once the terminal window is open, you may configure its terminal 
tool and transfer tool using the Terminal and Transfer commands 
in the Config menu. You can also configure the terminal tool via 
the Configure command in the Terminal menu, and the transfer 
tool via the Configure command in the Transfers submenu in the 
Terminal menu.



Again, configuring the terminal tool or transfer tool will cause the 
CTB to display a dialog box with a popup menu in the upper left 
area for selecting the desired tool and information specific to the 
tool in the lower area of the dialog.



Termy Features

File Conversion Utilities

Because the world of data communications frequently requires 
that data be mapped from one computer's representation to 
another's, Termy includes a list of file conversion utilities.
The conversions provided by Termy are all contained in the Tools 
menu. The tools allow you to convert text from UNIX or PC 
systems for use on the Mac and vice-versa. The other tools 
provided are MacBinary, BinHex, and uuencode.
NOTE, Termy can not convert a file in place. This means that the 
data resulting from a file conversion must be placed in a file other
than the one being converted.
Text Editor

Termy provides a text editor. This editor is driven by the 
commands in the top part of the File menu and the commands in 
the Edit menu.
Termy windows can display text of any length, but perform best 
when displaying data from a file, as opposed to text pasted into a 
Termy text window.
Termy text windows, do not work like regular Macintosh windows.
Termy text windows automatically wrap lines, but in so wrapping 
they insert a carriage return, making the wrap "permanent". The 
little arrow at the lower left of the Termy text windows indicates if 
lines are wrapped or not. If the arrow is straight, lines are not 
wrapped, otherwise they are.
The commands in the Selection submenu in the Edit menu, will 
operate on the currently selected text in the front most text 
window.


